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About This Document
This document is designed to serve as a tutorial on how to segment and flatten surfaces
using Caret5.

Conventions in this Document
•
•
•

All tutorial steps are identified by bullets.
Actions the user should take are in italics.
User-interface components are in BOLD.

Bug Reporting or Questions About Caret5 Software
Please use either the Caret users’ mailing list
(http://brainmap.wustl.edu/resources/caretnew.html#Help) or send an email to
caret@brainmap.wustl.edu. Suggestions are also welcome.

Downloading and Installing Caret5
Please see the document Caret 5.5 Tutorial – Introduction, Installation, and
Visualization.

Data Set for Use With This Tutorial
The data set for use with this tutorial is available in “zip” format from our SuMS
database. Follow the link
http://sumsdb.wustl.edu:8081/sums/archivelist.do?archive_id=6588227. On the SuMS
web page, there is column named name containing the file name:
caret_5.5_segment_flatten_register_tutorial.zip. To the left of this name in the action
column is a control. Select this control, which will popup a menu, and select download
to automatically start downloading the archive (set of files).
After downloading the data set, the archive needs to be uncompressed. Linux and
Macintosh users should run the command unzip
caret_5.5_segment_flatten_register_tutorial.zip. Windows XP users should place the
mouse over the downloaded file and press the right mouse button. From the popup
menu, choose Extract All and follow the prompts. Windows XP users may also extract
the file from the command line window by running caret_unzip
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caret_5.5_segment_flatten_register_tutorial.zip provided the caret/bin directory is in
the user’s PATH environment variable.

Prerequisites
This document assumes the reader has some familiarity with Caret5 such as the ability to
view surfaces and volumes, use the Display Control Dialog, and manipulate borders.
Please see one of the other tutorials if you are not familiar with viewing data in Caret5.

Volume File Types Supported by Caret5
Volume files of type AFNI, NIFTI, SPM, and Washington University’s “.ifh” format are
read using the Open Data File item on the File Menu. These volumes have sufficient
metadata that specifies the orientation and stereotaxic coordinates. If a volume of one of
these types is used, some of the steps in this tutorial will not be necessary.
Volume files of type Analyze, MINC, and VTK are read using the Import File menu
item on the File Menu. These file types rarely have sufficient metadata and it will
usually be necessary to set some of the volume’s attributes using Caret5 prior to
segmenting the volume. While most MINC volumes contain the required metadata, those
MINC volumes written by SureFit (used for segmentation and distributed by our lab prior
to this release of Caret5), do not contain the required metadata.
In this tutorial, an Analyze format volume file will be used that will require the setting of
attributes in Caret5.

Set the Current (Working) Directory
Prior to starting Caret5, place the anatomical volume (tutorial data set files) into a
directory containing no other files. Start Caret5 using the appropriate method for your
operating system. If you do not start Caret5 from a terminal window with the current
directory set to the directory containing the anatomical volume, perform the following
steps to set the current directory:
• Select Set Current Directory from the File Menu to launch the Choose
Directory Dialog.
• Using the Choose Directory Dialog, navigate to the directory containing the
anatomical volume as shown in Figure 1 and press the OK button.
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Figure 1 - Choose Current Directory Dialog

Read the Anatomical Volume
Import the Analyze Volume by performing the following steps:
• Select Import File from the File Menu.
• In the Import Data File Dialog, verify that the File type control is set to Analyze
Volume File (*.hdr) and that the Volume Type in the Import Selections section
is set to Anatomy.
• In the Import Data File Dialog, highlight the file named Human.case9.LR.7112C.hdr as shown in Figure 2 and press the Open button to load the file.
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Figure 2 - Import Data File Dialog

Anatomical Volume Requirements
A volume must meet several requirements to be segmented in Caret5. These
requirements are:
1) The volume must be standard T1-weighted MRI scans taken in vivo, in which
white matter is bright, gray matter is darker, and CSF is even darker.
2) The intensities should be consistent throughout the volume. For instance, in
Figure 3, the frontal lobes are much brighter than the remainder of the brain. This
volume would not be segmented correctly.
3) The volume must be in an LPI orientation. That is, the negative X is left, negative
Y is posterior, and negative Z is inferior.
4) The voxels must be 1mm cubic voxels (0.5mm for monkeys).
5) The volume’s stereotaxic coordinates must be set so that the coordinate (0, 0, 0) is
at the anterior commissure.
6) The volume must contain only a single hemisphere or part of a single hemisphere.
7) The voxels must be in the range 0 to 255.
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Figure 3 - Volume with Intensity Problems

Set the Volume’s Orientation
We know that the anatomical volume used in this tutorial is already in an LPI orientation
but this information was not in the header file. Set the volume’s orientation by following
these steps:
• Select Edit Volume Attributes from the Volume Menu to display the Volume
Attributes Editor Dialog.
• In the Volume Attributes section, select the Orientation Tab by clicking it with
the mouse. The current orientation is set to X-Unknown, Y-Unknown, and ZUnknown.
• Press the mouse over the X-Unknown item and a menu will pop up listing the
available choices. Change the X-Unknown to X-Left to Right. Perform the same
operation on the Y-Unknown and Z-Unknown items so that they read Y-Posterior
to Anterior and Z-Inferior to Superior respectively as shown in Figure 4.
• Press the Apply button to apply these changes to the volume.
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Figure 4 - Volume Attributes Editor Dialog
If you use a volume type that has sufficient metadata that describes the volume’s
orientation (such as an AFNI volume) Caret5 will automatically convert the volume to an
LPI orientation. Otherwise, the Flip About X Screen Axis, Flip About Y Screen Axis,
and Rotate Clockwise buttons in the Orientation section of the Volume Attributes Editor
can be used to bring the volume into an LPI orientation.

Set the Volume’s Stereotaxic Coordinates
Now that the volume’s orientation has been set, the volume’s stereotaxic coordinates
need to be established. The voxel sizes are already set to 1.0 mm for each dimension.
The origin values are the coordinates of the voxel that is the most left, posterior, inferior
voxel. To set the origin, we will find the anterior commissure and inform Caret5 of its
location. Caret5 will then use the voxel sizes along with the anterior commissure
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position to determine the origin. Locate the Anterior Commissure so that it is under the
crosshairs in the Main Window by performing the following steps:
• In the Main Window hold down the shift key, hold down the left mouse button,
and drag the volume to that the entire volume slice is visible.
• Click the mouse near the bottom of the anterior set of ventricles as shown in
Figure 5.
• Switch to a parasagittal view by pressing the mouse over the Volume Axis
Viewing Control in the toolbar (currently labeled H(XY)) and selecting P(YZ).
• Click the mouse over the anterior commissure as shown in Figure 6.
• Switch to a coronal view by changing the Volume Axis Viewing Control to
C(XZ) to view the crosshairs relation to the anterior commissure.
• Switch back to a horizontal view. The selected slices should now read 88, 122,
73. If they do not, adjust them using the arrows in the Toolbar as shown in
Figure 7.

Figure 5 - Crosshairs Near Ventricles
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Figure 6 - Crosshairs Over AC in Parasaggital View

Figure 7 - Crosshairs Over AC in Horizontal View
Now that the crosshairs are over the anterior commissure, the volume’s stereotaxic
coordinates are established by performing the following steps:
• On the Volume Attributes Editor Dialog, press the Coordinates Tab.
• Press the Use Main Window Crosshairs as AC Location to Determine Origin
push button. After doing so, you will see the origin values set to –88.0, -122.0,
and –73.0.
• Press the Apply button so that the volume’s origin is updated.
13

•

Press the R (Reset) button on the Main Window’s Toolbar to set the view of the
volume to the default view with the (0.0, 0.0, 0.0) stereotaxic coordinate at the
center of the window.

Setting the Voxel Range to 0 to 255
•
•
•
•

On the Volume Attributes Editor, press the Data Tab.
Press the Rescale Voxel Values button.
Change the Output Range values to 0 and 255 (or press the Set button in the
Output Range row and selection the top item, Byte – Unsigned.
Press the Close button on the Volume Attributes Editor Dialog.

Saving the Anatomical Volume
With the volume’s attributes properly set, the volume should be saved by following these
steps:
• Select Save Data File from the File Menu to display the Save Data File Dialog.
• Set the File Type to Volume File – NIFTI (*.nii *.nii.gz).
• In the Comment section add a comment stating that the volume is now an AC
centered coordinate system volume.
• Leave the Write Data File As set to Other.
• Verify that the Volume Type is set to Anatomy.
• Verify that the Volume File is set to Human.case9.LR.711-2C.hdr (the Analyze
volume that was imported).
• Change the File name to Human.case9.LR.711-2B_AC_ORIGIN+orig.nii so that
the Save Data File Dialog appears as shown in Figure 8.
• Press the Save button on the Save Data File Dialog to save the volume file.
• When asked “Would you like to create a Spec File ?”, click the Yes push button.
• In the Create Spec File Dialog, set the Species to Human by selecting the
Species push button and selecting human.
• Set the Subject to case9.
• Set the Hemisphere to Right (Note: even though we are saving a full volume, in
this tutorial we are going to segment the right hemisphere).
• Select the Space push button and set the space to 711-2B-111 (which is the
stereotaxic space of the anatomy volume). This value is just for informational
purposes.
• Select the Category push button and set the category to INDIVIDUAL.
• Press the OK button on the Create Spec File Dialog. As new files are created in
Caret5, the information from the Create Spec File Dialog will be used for default
file names.
• In the Spec File Name Dialog, the name of the spec file that will be created
(Human.case9.R.spec) using the information on the Create Spec File Dialog is
shown. Accept this name by pressing the OK button.
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Figure 8 - Save Data File Dialog for Saving Anatomical Volume

Cropping the Anatomical Volume to a Single
Hemisphere
Caret5’s segmentation algorithm requires that the input volume contain only a single
hemisphere. In the next steps, the anatomical volume will be cropped so that it contains
just the right hemisphere.
• Select Resize Underlay Volume from the Volume Menu.
• Press the Reset button on the Resize Volume if the cropping boundary lines are
not displayed on the volume in the Main Window.
• Press the Up Arrow for the X Min parameter so that it is set to 85 (or just enter
85 in the box).
• Press the Down Arrow for the X Max parameter so that it is set to 163.
• Press the Up Arrow for the Y Min parameter so that it is set to 15.
• Press the Down Arrow for the Y Max parameter so that it is set to 197 so that the
volume cropping boundary lines appear as shown in Figure 9.
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•
•
•

•
•
•

Change to a Parasagittal view of the volume so that the Z cropping parameters
can be set by using the Volume View Axis Control in the Main Window
Toolbar.
Press the Up Arrow for the Z Min parameter so that it is set to 30.
Press the Down Arrow for the Z Max parameter so that it is set to 158 so that the
volume cropping boundary lines appear as shown in Figure 10. Use a coronal
view to assist in verifying that the inferior part of the temporal lobe does not get
cut off.
Press the OK push button on the Resize Volume Dialog to crop the anatomical
volume.
Press the R button in the Main Window Toolbar to center the view of the
cropped right hemisphere. Note that the volume crosshairs center on the Anterior
Commissure.
The cropped volume in a horizontal view should appear as shown in Figure 11.

Figure 9 - Cropping Right Hemisphere Horizontal View

Figure 10 - Cropping Right Hemisphere Parasagittal View
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Figure 11 - Cropped Right Hemisphere
The cropped right hemisphere should be saved by performing the following steps:
• Select Save Data File from the File Menu.
• Change the File name to Human.case9.R.RIGHT_HEM+orig.nii.
• Update the comment to indicate that it is a cropped right hemisphere so that the
Save Data File Dialog appears as shown in Figure 12.
• Press the Save push button to save the file.
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Figure 12 - Save Data File Dialog - Cropped Right Hemisphere

Segmenting an Anatomical Volume
Now that you have a single hemisphere that is AC-centered, in LPI orientation, with 1.0
mm cubic voxels, it is now time to start the segmentation process.
• Select SureFit Operations (Segmentation) from the Volume Menu.
• The first page of the Surefit Segmentation Operation Dialog is Change/Verify
Current Directory page. The directory already be set to the directory containing
the volume files as shown in .
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Figure 13 - SureFit Operations Set Directory Page
•

The second page of the SureFit Segmentation Operations Dialog is the Subject
Information Page as shown in Figure 14. This information is what was entered
on the Create Spec File Dialog. Press the Next push button.
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Figure 14 - SureFit Operations Subject Information Page
•

The Spec File Selection Page shows the Spec File that will be updated as new
data files are created during the segmentation process as shown in Figure 15. If
you had not created a spec file, the name for the new spec file would be entered
on this page. Press the Next push button to continue.
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Figure 15 - SureFit Operations Spec File Page
•

The Volume Selection Page allows selection of the volume that will be processed
by the SureFit segmentation algorithm as shown in Figure 16. Press the Next
push button to continue.
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Figure 16 - SureFit Operations Volume Selection Page
•

The Volume Attributes Page describes requirements for the volume that is to be
processed by the SureFit segmentation algorithm as shown in Figure 17. These
requirements were met during previous steps of this tutorial. Press the Next push
button to continue.
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Figure 17 - Segmentation Operation Volume Attributes Page
The Set Gray and White Matter Peaks page is used to provide information about the
distribution of gray and white matter in the volume. On the left side of page is a
histogram showing the distribution of voxels in the anatomical volume. On the right side
of the page are controls for adjusting the gray and white matter peaks. Selecting the
round or diamond shaped button to the left of Gray Peak Control or the White Peak
Control colors all voxels exceeding that peak in green. Caret5 will attempt to identify
the gray and white peaks but they normally will need some adjustment.
For additional information on drawing peaks visit the web page
http://brainvis.wustl.edu/help/peak_tweaking/index.html.
•
•
•
•

Use the Y-Max slider to control the display of the histogram so that the peaks are
easily visible.
Press the arrows in the Gray Peak Control so that the gray peak is set to about
57 (to the left of the actual gray peak).
Press the arrows in the White Peak Control so that the white peak is set to about
106 (just to the left of the white peak)
The Set Gray and White Matter Peaks Page should appear as in Figure 18.
Press the Next push button.
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Figure 18 - SureFit Operations Set Gray and White Matter Peaks Page
•

The Segmentation Operations Page allows the user to choose the operations that
are to be carried out during the segmentation process. While the SureFit
algorithm attempts to identify and correct all topological defects (handles), there
are usually a few handles that the algorithm is unable to correct. So, to save a
little time, deselect the Generate Very Inflated Surface, Generate Ellipsoid
Surface (used for Flattening) and Create Curvature, Depth, and Paint
Attributes check boxes so that the Segmentation Operations Page appears as in
Figure 19. Press the Next push button.
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Figure 19 - Segmentation Operations Page
•

•

An Information Dialog will appear informing you that any previously generated
surface files will be removed from the spec file and deleted due to the fact they
will be incompatible with the newly generated surfaces produced by the
segmentation process. Press the OK button and the segmentation process will
begin. This may take up to several hours depending upon the speed of your
computer. A progress dialog will be displayed during the segmentation process
indicating the step that is being performed. The Automatic Error Correction step
will take the longest amount of time.
At the conclusion of the SureFit Algorithm the Segmentation Complete Page
will appear as shown in Figure 20. It will list the execution time and, if a surface
was generated, the number of topological defects (handles) still remaining in the
surface. Press the Close push button on the SureFit Segmentation Operations
Dialog.
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Figure 20 - SureFit Operations Segmentation Complete Page

Manual Error Correction
In most cases, there will be handles remaining after the initial segmentation. In addition,
the SureFit algorithm may classify non-cortical material near the eye or in the midbrain
as cortex. Arteries and blood vessels may also get segmented and are usually very bright
in the anatomical volume. As a result, manual error correction must be performed. At
times, this may be an iterative process in which multiple cycles of manual correction of
the segmentation volume and surface generation are performed.
• Use the Model Selection Control to display VOLUME in the Main Window.
• Press the D/C button in the Main Window Toolbar to show the Display Control
Dialog.
• Set the Display Control Dialog’s Page Selection so that the Overlay/Underlay
Volume page is shown.
• Set the Underlay to Anatomy. Set the Primary Overlay to the newest
segmentation volume, most likely one with “Error_Corrected” in its name.
• Select Viewing Window 2 from the Window Menu.
• In Viewing Window 2, display the FIDUCIAL surface.
• Press M in the Viewing Window 2’s Toolbar to place the surface in a medial
view. Look for non-cortical material that may appear as shown in FIGURE???
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•

and is shown by a green symbol. Click on the non-cortical material that is part of
the fiducial surface and you will see the volume slice and crosshairs in the Main
Window relocate to the non-cortical material.
The problems near the eye are found in horizontal slice 14.

Figure 21 - Segmentation

Figure 22 - Segmentation Near Eye
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Figure 23 - Segmentation Near Eye Corrected
•
•
•
•
•

Switch to a coronal view. Check for erroneous segmentation in midbrain
structures as in Figure 24. This part of the segmentation will need to be removed.
To edit segmentation voxels select Edit Voxels from the Volume Menu’s
Segmentation submenu.
On the Segmentation Volume Editor, set the Editing Mode to Turn Voxels Off.
Set the Brush Size to 3x3 (or larger). Press the Apply push button.
Place the mouse over the midbrain structure and hold down the left mouse button.
The mouse will act as an eraser. Continue moving the mouse around, with the left
mouse button held down, until all of the segmentation voxels that overlay the
midbrain structures have been removed. Use the middle slice control in the
toolbar to correct other slices that contain segmentation voxels over the midbrain
structures. Check slices ranging from about 90 to 140.

In some cases, it may not be necessary to remove all of voxels on the midbrain structures.
Instead, just make sure that the voxels overlaying the midbrain structures no longer
connect to the voxels overlaying the white and gray matter. Once you believe the
segmentation voxels overlaying the two structures are no longer connected, select
Remove Islands form the Volume Menu’s Segmentation submenu. You might want to
save the segmentation volume prior to using this option.
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Figure 24 - Midbrain Before Correction

Figure 25 - Midbrain After Cleanup
Now that the voxels overlaying the midbrain structure have been removed it is time to
look for handles (topological defects).
• Select Find Handles from the Segmentation sub-menu on the Volume Menu.
• In the Volume Handle Finder Dialog, check the box next to Y Axis (Coronal) in
the Search section.
• Press the Search For Handles push button in the Search section of the dialog.
This will require a few minutes to search the volume for handles. When
complete, the Volume Handle Finder Dialog will appear similar to that in Figure
26 with possibly different handles listed. Voxels that make up the “hole” of the
handle are colored in purple by creating an RGB Volume and displaying it as the
Secondary Overlay. For each handle found, the dialog will list the slice indices of
one voxel in the handle, the number of slices along the search axis that the handle
is within, and the total number of “hole” voxels in the handle.
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Figure 26 - Segmentation Volume Handle Finder Dialog
•
•
•

Select Window 2 from the Window Menu.
Use the Model Selection Control in the Viewing Window 2 to show the
INFLATED surface. Notice that surface nodes around handles are colored in
purple. It may be necessary to switch to a medial or ventral view.
In the Handles section of the Volume Handle Finder Dialog, click one of the
listed handles with the mouse. The volume slices should jump to the handle with
the “inside” of the handle shown in purple. Sometimes it is necessary to adjust
the viewed slice by one slice.

When correcting errors in the volume it is sometimes helpful to turn off the segmentation
and the RGB coloring that shows the handles to view the underlying segmentation to help
determine the type of correction necessary.

Error Correction Example
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This example is not from this tutorial’s segmentation. Here is an instance where the
segmentation has jumped across the banks of a sulcus in the occipital lobe. Figure 27
shows the segmentation with the handle in purple, Figure 28 shows the segmentation,
Figure 29 shows just the anatomical volume, Figure 30 shows the segmentation with the
voxels that should be removed in a black encircled region, and Figure 31 shows the
handle on the inflated surface.

Figure 27 - Handle Voxels Highlighted In Purple

Figure 28 - Handle Voxels Without Highlighting

Figure 29 - Anatomical Volume in Handle Region

31

Figure 30 - Voxels That Need to Be Remove to Fix Handle

Figure 31 - Handle in Surface

The following steps are taken to correct this handle.
• Set the Primary Overlay to the Segmentation Volume.
• Set the Secondary Overlay to No Coloring (Removes purple coloring of voxels
inside the handle).
• Set the Underlay to Anatomy.
• Select Edit Voxels from the Segmentation sub-menu on the Volume Menu.
• On the Segmentation Volume Editor Dialog, set the Editing Mode to Turn
Voxels Off (In this mode, the mouse pointer functions like an eraser removing
segmentation voxels.
• Set the Brush Size to 3x3. This means that when the mouse is clicked or dragged
(moved with the left mouse button held down) over a voxel, the voxel and its
eight surrounding neighbors in the slice will be affected by the segmentation
editing operation. Leave the Brush Thickness set at Current Slice Only so that
only segmentation voxels in the current slice will be modified. The
Segmentation Volume Editor should appear as shown in Figure 32.
• Press the Apply push button on the Segmentation Volume Editor Dialog.
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•

Place the mouse over a segmentation voxel that is fusing the banks of the sulcus
together. Hold down the left mouse button and drag the mouse over the voxels
that are causing the problem. When the offending voxels are removed, release
the mouse button.

Figure 32 - Segmentation Volume Editor Dialog

Correcting handles involves adding voxels to the segmentation or removing voxels from
the segmentation. When voxels need to be removed from the segmentation, set the
Editing Mode of the Segmentation Volume Editor to Turn Voxels Off. When voxels
need to be added, set the editing mode of the Segmentation Volume Editor to Turn
Voxels On. The mouse will function as an eraser or a paint brush. After making any
changes to the Segmentation Volume Editor Dialog, press the dialog’s Apply push
button. In the Main Window with the segmentation volume displayed, just move the
mouse with the left mouse button held down to change the status of segmentation voxels.
If there is a hole in a slice that needs to be filled, set the Editing Mode to Flood Fill 2D.
Clicking the mouse on a voxel that is not part of the segmentation will fill all connected
voxels that are not part of the segmentation. If at any time a mistake is made while
editing the surface, pressing the Undo push button will restore the values of voxels that
were just changed. It may be necessary to press the Undo push button several times to
back out changes.
When using the Volume Handle Finder to locate and correct handles, correct handles
along one axis at a time. When you think the listed handles have been fixed, press the
Search For Handles push button again to verify that no new handles were created and
handles were corrected. Once no handles are reported for an axis, search along a
different axis and correct the handles found. The Volume Handle Finder Dialog is not
guaranteed to find all handles so it may be necessary to inspect a surface, such as the
inflated surface, for handles.
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Save Corrected Segmentation Volume
Once all of the handles have been corrected, the segmentation volume should be saved.
• Select Save Data File from the File Menu.
• Set the File type to Volume File – AFNI (*.HEAD).
• In the bottom of the Save Parameters Dialog, set the Volume Type to
Segmentation.
• Set the Volume File to the “ErrorCorrected” segmentation volume that was just
edited.
• In the Comment section, add information that errors were corrected.
• Change the name of the volume file from
Human.case9.R.Segment_ErrorCorrected.<date>.HEAD to
Human.case9.R.Segment_ErrorCorrected_fix1.<date>+orig.HEAD.
• Press the Save push button to save the error corrected segmentation volume file.

Generating Final Surface and Surfaces For Flattening
Since the segmentation volume has been modified to correct topological errors, the
surface needs to be regenerated.
• Select SureFit Operations (Segmentation) from the Volume Menu.
• On the Subject Information Page, just press the Next push button since the
subject information is already loaded into the page.
• On the Spec File Selection Page, just press the Next push button since the spec
file is already set.
• On the Volume Selection Page, set the Volume Type to Segmentation and the
Volume File to the Segmentation Volume File that was just edited and saved so
that the Volume Selection Page appears like that in Figure 33. Press the Next
push button.
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Figure 33 - SureFit Operations Volume Selection (Segmentation Volume)
•
•

On the Volume Attributes Page, just press the Next push button.
The Segmentation Operations Page has some of its operations disabled (in a
light shade of gray and not responsive to the mouse). These options are disabled
since we are starting with a segmentation volume instead of an anatomical
volume. Deselect Automatic Error Correction since that process has already
been performed. Verify that Generate Raw and Fiducial Surfaces, Generated
Inflated Surface, Generate Very Inflated Surface, Generate Ellipsoid
Surface, Create Curvature, Depth, and Paint Attributes, and Auto Save
Generated Data Files are selected as shown in Figure 34. Press the Next push
button to generate all of the surface and the surface attribute files. Select OK on
the Information Dialog informing you that previously generated surfaces and
related files will be deleted. In the Partial Hemisphere Padding Dialog, leave
all options deselected and press the OK button. If you were to segment a partial
hemisphere, selections are made in the Partial Hemisphere Padding Dialog to
inform the surface generation algorithm where the hemisphere was cut.
Generating the surfaces and related files may take a half hour or more depending
upon your computer’s speed.
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Figure 34 - Segmentation Operations Page (Final Surfaces)
•
•
•
•
•
•
•

Press the Close push button on the SureFit Segmentation Operations dialog.
Press the D/C button in the Main Window’s Toolbar to display the Display
Control Dialog.
Set the Display Control Dialog to display the Overlay/Underlay – Surface
page.
Set the Underlay to Shape with Depth as the selected column.
View the different surfaces in the Main Window.
Set the selected Shape column to Folding (Mean Curvature).
View different surfaces with curvature shading the surface.

Surface Flattening
Now that the ellipsoid surface has been generated it is time to flatten the surface.
•
•
•

Set the Main Window so that it displays the Ellipsoid Surface.
Select Flatten Full or Partial Hemisphere from the Surface Menu.
On the Flatten Full or Partial Hemisphere Dialog, set the Flattening Type to
Full Hemisphere (Ellipsoid) and Morph Sphere.
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•
•
•

Since Caret5 starts with a volume whose origin is at the anterior commissure and
Caret5 produces surface with the origin at the anterior commissure, the Anterior
Commissure Position should be set to (0, 0, 0).
Set the Border Template Cuts to Human Right Standard Cuts.
The Flatten Full or Partial Hemisphere Dialog should appear as in Figure 35.
Press the OK button to start the flattening process. A dialog will pop up asking
you to confirm that the anterior commissure is at the origin. Press the Yes,
Continue Flattening push button.

Figure 35 - Flatten Full Hemisphere Dialog

Correct Template Medial Wall Boundary and Calcarine Cut
Borders
For a very thorough description of drawing the borders for flattening (and registration)
visit the web page http://brainvis.wustl.edu/help/landmarks_core6/landmarks_core6.html.
After a short time the “compressed medial wall” surface will appear with a red border
somewhat enclosing the medial wall region and blue borders showing where cuts will be
made. See Figure 36.
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Figure 36 - Template Cuts on Compressed Medial Wall Surface
•
•
•
•
•
•
•

Drag the Continue Flattening Full Hemisphere Dialog to the side.
Select Viewing Window 2 from the Window Menu.
Use the Model Selection Control in Viewing Window 2 to view the
INFLATED surface. It may also be helpful to enlarge Viewing Window 2.
Switch to a medial View in Viewing Window 2 by pressing the M button in the
Toolbar.
Press the View button in the Main Window Toolbar to make sure that Caret is in
View Mode.
Click the mouse (perform Node Identification operations) around the boundary of
the inflated surface’s medial wall. The green node identification symbols will
appear on both the inflated and compressed medial wall surface.
After identifying the boundary of the medial wall, identify the calcarine sulcus so
that the inflated surface appears as in Figure 37 and the compressed medial wall
surface appears as in Figure 38.
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Figure 37 - Identifying Medial Wall and Calcarine on Inflated Surface in Medial
View

Figure 38 - Identified Medial Wall and Calcarine Cut on Compressed Medial Wall
Surface

•
•
•
•

Select Delete Border With Mouse from the Borders sub-menu of the Layers
Menu. Click the mouse over the existing medial wall and calcarine borders to
delete them.
Select Draw Border from the Borders sub-menu of the Layers Menu to display
the Draw Borders Dialog.
Press the Select push button and in the Name Selection Dialog highlight
MEDIAL.WALL with the mouse and press the OK push button.
Press the Apply push button on the Draw Borders Dialog.
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•

•
•

•
•
•

In the Main Window, move the mouse over one of the green symbols around the
medial wall. Hold down the left mouse button and follow the green symbols to
trace out the medial wall. When the mouse gets near the start of the new border,
release the left mouse button, hold down the shift key, and click the left mouse
button to tell Caret5 that you are done drawing the medial wall border.
In the Draw Border Dialog, press the Select push button. In the Name Selection
Dialog highlight Calcarine Cut and press the OK push button.
Press the Apply push button on the Draw Border Dialog. Now use the mouse to
draw a border along the calcarine sulcus. Be sure that the border denoting the
calcarine sulcus crosses the medial wall boundary. So, start drawing the border
inside the medial wall and continue to the posterior part of the calcarine sulcus.
The new medial wall and calcarine sulcus borders should appear similar to that in
Figure 39.
Press the Close push button on the Draw Borders Dialog.
Press the Close push button on Viewing Window 2.
Press the Continue Flattening push button on the Continue Flattening Full
Hemisphere Dialog. This next process will take several minutes.

Figure 39 - Corrected Medial Wall and Calcarine Cut on Compressed Medial Wall
Surface
The initial flat surface will appear similar to that in Figure 40. The green symbols may
be removed by selecting Clear Node Identify Symbols from the Identify sub-menu of the
Surface Menu or by pressing the CID button in the Identify Window’s Toolbar. If there
are any large regions of crossovers (shown in red), indicating handles that are still present
in the surface, it may be necessary to go back and edit the segmentation volume to correct
the handles. If the handles are found the edge of the flat surface they can be removed by
following the instructions in the Initial Flattening Dialog.
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Figure 40 - Initial Flat Surface
•

Continue the flattening process by pressing the Continue Flattening push button
on the Initial Flattening Dialog.

Multi-Resolution Morphing (Surface Distortion Reduction)
•

•

The Multiresolution Morphing – Flat Dialog will appear. This dialog contains
the parameters that will be used by the multi-resolution morphing algorithm. This
algorithm will reduce distortions in the flat surface caused by flattening. It rarely
necessary to alter these parameters so just press the OK push button.
The Multiresolution Morphing – Sphere Dialog will appear. This contains
parameters for the reducing the distortion in the spherical surface. Press the OK
push button to continue. The multi-resolution morphing of the flat and spherical
surfaces will take a half-hour or longer to complete.

Aligning the Surfaces to Standard Orientation
When the multi-resolution morphing process is complete, several dialogs will pop up.
• Drag the Align Surfaces Dialog to the side.
• The Spherical Morphing Measurements Dialog displays measurement
information collected during spherical morphing. Press the Close push button to
remove it.
• The Flat Morphing Measurements Dialog displays measurement information
collected during flat morphing. Press the Close push button to remove it.
• Press the D/C button in the Main Window Toolbar to display the Display
Control Dialog.
• Change to the Overlay/Underlay – Surface Page.
• Set the Underlay to Shape.
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•
•
•
•
•
•

Set the Shape column to Folding (Mean Curvature).
Set the Primary and Secondary Overlays to No Coloring.
Press the Close push button on the Display Control Dialog to remove it.
Place the Align Surface(s) to Standard Orientation Dialog to the side of the
Main Window.
Press the Reset push button on the Align Surface(s) to Standard Orientation
Dialog.
In the Main Window, click the mouse on the ventral tip of the Central Sulcus
(near the middle of the surface) The ventral tip is shown by the green square in
near the center of Figure 41.

Figure 41 - Unaligned Flat Surface
•

•
•
•

Hold down the Shift Key and click the mouse on the dorsal-medial tip of the
Central Sulcus (opposite end of the Central Sulcus from click made in last step).
You should see X and Y values for the Ventral and Dorsal-Medial Tips of the
Central Sulcus in the Align Surface(s) to Standard Orientation Dialog.
In the Spherical Surface section of the Align Surface(s) to Standard
Orientation Dialog, check the box to the left of Align Sphere.
Press the Apply push button on the Align Surface(s) to Standard Orientation
Dialog. After a short time the flat surface should appear similar to Figure 42.
Press the Close push button on the Align Surface(s) to Standard Orientation
Dialog.
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Figure 42 - Aligned Flat Surface

Since data files (flat coordinate, spherical coordinate, and latitude longitude) have been
modified by the alignment process, they need to be saved.

Saving the Aligned Surface Files
•
•
•
•
•
•
•

Select Save Data File from the File Menu.
Set the File type to Coordinate Files (*.coord).
Near the bottom of the dialog verify that Coord File is the
CYCLE5_OVERLAP_SMOOTH coordinate file.
Set the Coord Frame to Cartesian Standard.
Set the Orientation to Left, Posterior, Inferior.
Add information about alignment to standard orientation to the Comment section.
Change the File name to
Human.case9.R.FLAT_ALIGNED.<date>.<#nodes>.coord so that the dialog is
similar to that in Figure 43.
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Figure 43 - Save Aligned Flat Coordinate File
•
•
•
•
•
•
•
•
•

Press the Save push button to save the file.
Select Save Data File from the File Menu.
Near the bottom of the dialog set the Coord File to the SPHERE_CYCLE4
coordinate file.
Set the Coord Frame to Spherical Standard.
Set the Orientation to Left, Posterior, Inferior.
Change the File name to
Human.case9.R.SPHERE_ALIGNED.<date>.<#nodes>.coord.
Press the Save push button to save the file.
Select Save Data File from the File Menu.
Set the File type to Latitude Longitude Files (*latlon).
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•
•

Change the File name to Human.case9.R.LAT_LON.<date>.<#nodes>.latlon.
Press the Save push button to save the file.

At this point you are done.
* Select Exit from the File Menu (Quit from the Caret Menu for Macintosh users).
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Spherical Registration
Caret5 provides two registration methods, flat and spherical, for bringing one surface into
register with another using landmarks to constrain the deformation. The landmarks
consist of borders that identify regions identified on both surfaces such as the medial wall
boundary and various sulci. There are several advantages of spherical registration over
flat registration. First, the spherical surfaces are closed (contain no cuts), eliminating the
requirement for landmarks along the surface perimeter in flat registration. Secondly,
spherical registration requires six landmarks, two along the medial wall boundary, and
one each on the calcarine sulcus, the central sulcus, the sylvian fissure, and the superior
temporal gyrus.
The first step in performing a spherical registration is to draw the needed registration
landmarks (borders) on both the individual and atlas surfaces. For good quality
registration, six registration landmarks are needed. Fortunately, three of the six required
registration landmarks are automatically created during the flattening of a full
hemisphere. You may recall drawing the medial wall and calcarine cuts during the
flatten full hemisphere process. The medial wall cut becomes two of the registration
landmarks by splitting it into two pieces where it intersects both the frontal and calcarine
cuts. The calcarine cut becomes the third registration landmark. You will need to draw
the other three required registration landmarks that denote the central sulcus, the sylvian
fissure, and the superior temporal gyrus.
For a very thorough description of drawing the borders for registration (and flattening)
visit the web page http://brainvis.wustl.edu/help/landmarks_core6/landmarks_core6.html.
There are two other very important considerations regarding the landmark borders. First,
both the individual and atlas landmarks must consist of the same number of borders with
a one-to-one correspondence in the border names. Secondly, each of the corresponding
landmark borders must be oriented in the same manner. In other words, each of the
corresponding borders must begin and end in corresponding anatomical locations.
•
•
•
•
•
•
•
•
•

Exit out of any Caret5 programs that are running.
Change into the tutorial’s registration/INDIVIDUAL.1582.L directory.
Start Caret5.
Open the Human.1582.L.REGISTER-with-ATLAS.03-05.65950.spec
specification file.
In the spec file dialog press the Select All button, deselect both of the border
projection files, and press the Load button to load the files.
In the Main Window, use the Model Selection Control to select the FLAT
surface.
Press the Toolbar:D/C button to launch the Display Control Dialog.
On the Overlay/Underlay – Surface panel, set Shape to Folding – Fiducial –
1582L to see the folding (mean curvature) on the flat surface.
Select Layers: Borders: Draw Border to launch the Draw Border Dialog.
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•
•
•
•
•
•

•
•
•
•
•
•

Press the Select button in the Draw Borders Dialog’s Attributes frame.
Select the name LANDMARK.CentralSulcus and press the OK button in the
Name Selection Dialog.
Set the Resampling to 4.0.
Verify that the Type is set to Open.
Press the Apply in the Draw Borders Dialog.
Draw a border that follows the fundus of the central sulcus. Be sure to start at the
bottom of the central sulcus near the middle of the window and draw upwards to
the other end of the central sulcus (yellow border in Figure 45). If you do not
know how to draw a border, see the borders section of this document.
Press the Select button in the Draw Borders Dialog.
In the Name Selection Dialog, choose the LANDMARK.SylvianFissure item
and press the OK button to close the Name Selection Dialog.
Draw a border that follows the sylvian fissure. Start at the end of the sylvian
fissure near the middle of the surface and draw left and down as show in Figure
45.
Use the Main Window’s Model Selection Control to view the INFLATED
surface.
Press the Main Window Toolbar’s View button to place the mouse back into
view mode.
Use the ID Node function to identify (click the mouse) along the anterior portion
of the superior temporal gyrus.

Figure 44 - Node Identified Along Superior Temporal Gyrus
•
•
•

Use the Main Window’s Model Selection Control to return to viewing the
FLAT surface.
Press the Selection button in the Draw Borders Dialog.
In the Name Selection Dialog, choose the LANDMARK.SF_STSant item and
press the OK button to close the Name Selection Dialog.
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•
•
•
•

Press the Draw Borders Dialog’s Close button.
Starting at the top of the identified nodes, draw superior temporal gyrus border.
Switch the Display Control Dialog to the Border panel.
In the Main tab, select Show First Link Red. You will see the beginning of each
border in red as in Figure 45.

Figure 45 - Central Sulcus, Superior Temporal Gyrus, and Sylvian Fissure
Landmarks
•

•

•
•

•

Select Layers: Borders: Project Borders. Leave the Projection Method set to
Nearest Tile and press the OK button in the Border Projection Dialog. This
will project the three borders that you have just drawn to all of the other surfaces.
Use the Model Selection Control to view the SPHERICAL surface in the Main
Window. Rotate the surface to view the Central Sulcus landmark (in yellow) and
the Sylvian Fissure landmark (in cyan).
Press the Spec button in the Main Window Toolbar.
Press the Open button to the left of the border projection file
Human.1582.L.Full.LANDMARKS.FromFlattening.65960.borderproj. In the
Append or Replace Dialog, choose Append. This loads the landmarks that
were automatically created when the hemisphere was flattened.
In the Main Window’s Toolbar, press the M button to get a medial view of the
spherical surface. You will see additional landmarks around the medial wall and
along the calcarine sulcus (Figure 46).
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Figure 46 - Landmarks on Flat

Figure 47 - Landmarks on Sphere
•
•
•
•
•

Choose File: Save Data File.
In the Save Data File Dialog, set the File Type to Border Projection Files.
In the File Name text box, change the name to
Human.1582.L.Full.LANDMARKS.ForSphericalRegistration.65950.borderproj.
Press the Save button to save the border projection file.
Exit out of this Caret program. You will be informed about unsaved border files
that were created during the border projection process. We do not need these
since the border projection file was saved, so, quit without saving.

The INDIVIDUAL surface now has the landmarks required for registration. The ATLAS
surface already has its needed landmarks so it is now time to execute the registration
process.
•

Change up one directory level so that you are in the tutorial’s
REGISTER_SPHERE directory.
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•
•
•
•
•

•
•
•
•

•
•
•
•
•

Start Caret5.
Select Surface: Deformation: Run Spherical Surface Deformation to launch
the Spherical Surface Deformation Dialog.
Press the Individual Tab.
Press the Spec File button.
In the Choose Spec File Dialog, go into the INDIVIDUAL.1582.L directory,
select the Human.1582.L.REGISTER-with-ATLAS.03-05.65950.spec
specification file, and press the Open button. This results in the remaining fields
of the dialog being set.
Press the Border File button. Make sure the selected border file is set to
Human.1582.L.Full.LANDMARKS.ForSphericalRegistration.65950.borderproj.
Press the Atlas tab.
Press the Spec File button.
In the Choose Spec File Dialog, go into the ATLAS_LEFT_HEM directory,
select the Human.colin.L.REGISTER-to-INDIVIDUAL.03-05.71785.spec
specification file, and press the Open button.
Press the Spherical Parameters tab.
Press the Select Standard Parameters button (near the bottom of the dialog).
In the Choose Registration Parameters Dialog, press the Human to Human
radio button and press the OK button.
Press the OK button on the Spherical Surface Deformation Dialog to start the
deformation. This will take 10 to 20 minutes depending upon the speed of the
computer.
Part way through the deformation process, you might get a dialog reporting that
crossovers (spherical surface tangles) were encountered. If the number is small
(i.e. less than 12) choose to continue the deformation process. If the number is
larger, it is possible that one of the landmarks, central sulcus, or sylvian fissure
was drawn in the wrong orientation. Verify that the landmarks are correct.

Viewing Registration Results
•
•
•
•

•

Press the OK button on the Deformation Completed Dialog. Exit out of this
Caret5.
Change into the REGISTER_SPHERE/ATLAS_LEFT_HEM directory.
Start Caret5.
In the Open Spec File Dialog are two spec files. Choose the
deformation_Human.1582.L.REGISTER-with-ATLAS.03-05.71785.spec which
contains the individual’s data (1582.L) registered to the atlas surface.
In the Spec File Dialog, in addition to the default files, select either of the Area
Color Files, either of the Border Color Files, the
deformed_Human.1582.L.CartesianGrid.71785 Border Projection file, the
deformed_1582.L.Eye-movements-attention.71785.metric Metric file, and both of
the Paint files. Deselect the
deformed_Human.1582.L.COMPOSITE.71785.surface_shape Surface Shape
file and select the Human.colin.L.COMPOSITE.71785.surface Surface Shape file.
Press the Load button to load the files.
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•
•
•
•
•
•
•

In the Main Window, use the Model Selection Control to view the FLAT
surface. The Cartesian grid borders provide feedback on the surface deformation.
Press the ToolBar:D/C button to launch the Display Control Window.
Press the Borders button near the bottom to turn off the borders.
Set the Primary Overlay to Paint and select the Paint column Geography –
1582.L to see the individual’s sulcal pattern deformed to the atlas.
Switch the Paint to Geography – Human.colin.L to view the atlas’ geography and
contrast it with the individual’s geography.
Set the Primary Overlay to Metric to view the individual’s functional data
deformed to the atlas.
Exit this Caret5.
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Command Line Segmentation
To segment at the command line, the volume must be in an LPI orientation with its origin
set so that the (0, 0, 0) stereotaxic coordinate is at the anterior commissure. The gray and
white peaks must also be known.
VOLUME SEGMENTATION
caret_command -volume-segment <operation_code> \
<f-gray-peak> <f-white-peak> \
<padding-code> <structure> <spec-file-name>
<anat-or-segment-volume>
Operation_Code characters
Specify each with either a "Y" or "N".
All characters must be specified.
Character Operation Description
--------- --------------------1 Disconnect Eye and Skull
2 Disconnect Hindbrain
3 Use High Threshold for Hindbrain disconnection
4 Cut Corpus Callossum
5 Generate Segmentation
6 Fill Ventricles
7 Automatic Error Correction
8 Generate Raw and Fiducial Surfaces
9 Generate Inflated Surface
10 Generate Very Inflated Surface
11 Generate Ellipsoid Surface (For Flattening)
12 Generate Hull Surface
13 Generate Curvature, Depth, and Paint Attributes
gray-peak specifies the intensity of the gray matter peak in the
anatomy volume.
white-peak specifies the intensity of the white matter peak in the
anatomy volume.
padding-code
Specify padding for any cut faces when segmenting a partial hemisphere.
Specify each with either a "Y" for padding or "N" for no padding.
All characters must be specified.
Character Padding Description
--------- ------------------52

1
2
3
4
5
6

Pad Negative X
Pad Positive X
Pad Posterior Y
Pad Anterior Y
Pad Inferior Z
Pad Superior Z

structure Specifies the brain structure.
Acceptable values are RIGHT or LEFT
spec-file-name Name of specification file.
anat-or-segment-volume Name of input volume.
The volume must be in a Left-Posterior-Inferior orientation and
its stereotaxic coordinates must be set so that the origin is
at the anterior commissure.
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